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LAB ASSIGNMENTS (MS EXCEL 2013) 
 

STARTING MSEXCEL 

 
Click onto Microsoft Excel 2013 Icon on the 

Task Bar  

or 

Click on Windows Button (left bottom Corner) - Click the MS Excel 2013  

 

When Excel is started, a new blank Worksheet appears on the screen, which consists of 

number of columns ( 16,384) and rows (10,48,576). Each column names as A, B C…. XFD 

and rows numbers as 1,2,3…… 10,48,576. Each workbook by default consists of one sheet 

named as sheet1 but we can add any number of sheet.. 

 

The following is the screen layout and different components of MS Excel 2013. 

 
 

 

 

 
 

 

 

The Quick Access Toolbar 

Ribbon 

Worksheet Working Area 

Tabs 

Groups 

Commands Formula Bar 

Status Bar 

Scroll Bar 
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Practice moving around in the worksheet using Arrow Movement Keys, Page Up, Page Down, 

Home, Ctrl + Home etc. 

Press To 

DOWN ARROW () Move to the next row 

UP ARROW () Move to the previous row 

RIGHT ARROW (➔) or 

TAB key  

Move to the next column  

LEFT ARROW () or Shift 

TAB 

Move to the previous column  

PAGE DOWN Move down to next page (screen)  

PAGE UP Move up to previous page (screen)  

HOME Move to the first column  

CTRL+ RIGHT ARROW 

(➔) 
• Move to last column (if worksheet is blank 

• Move to last column of the typed matter (if worksheet 

has data)  

CTRL+ LEFT ARROW () • Move to first column (if worksheet is blank 

• Move to previous non blank column of the typed matter 

(if worksheet has data) 

CTRL+HOME Move to the first cell of the worksheet i.e. A1 

 

1. Exit from the Worksheet either clicking on File Tab and selecting Close or clicking onto 

Upper   X  on the Excel Window. Do not save file when prompted 

2. Start MS Excel Once Again. 

 

Exercise – 1 

Prepare the following worksheet : 

 

Number of Schools in Selected Cities of Rajasthan 

District Secondary Primary Total 

Ajmer 68 114  

Jaipur 124 186  

Kota 78 64  

Sikar 39 84  

Sawai 

Madhpur 

52 109  

Total    

 

After completion of the above worksheet do the following: 

a) Save the worksheet with name school by clicking on Office Button followed by SAVE or 

Clicking on to FLOPPY Icon. 

b) Find out total number of schools in each district using formula i.e. =b3+c3  (Remember 

formula starts with a = sign followed by cell reference and in between operator + , similar 

to what you do on calculator). You may copy this formula by dragging it to cells 

downward. 
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c) Also calculate total number of secondary school and primary school using SUM function. 

(Guess why we are using function in place of formula  =SUM(RANGE)) 

d) Save worksheet and Exit from MS Excel (Hope you remember how to save and exit from 

MS Excel) 

e) Select cell containing column titles and align them to centre by clicking on Paragraph 

group and clicking on Centre Alignment text and also make them Bold. 

f) Save above workbook and exit from EXCEL (Click on X on the top right corner)  

 

Exercise – 2:  Open the worksheet created in the exercise -1 (school) (Opening existing 

worksheet – Click on File Tab – Click on Open– click on school). Following will be displayed 

with Total column filled: 

 

Number of Schools in Selected Cities of Rajasthan 

District Secondary Primary Total 

Ajmer 68 114  

Jaipur 124 186  

Kota 78 64  

Sikar 39 84  

Sawai 

Madhpour 

52 109  

Total    

Average    

 

After completion of worksheet, do the following: 

a) Increase the column width of the column A to so as to accommodate complete text in 

column. 

b) Increase column width of B, C and D together to accommodate data. 

c) Find out average number of secondary school using function of average. 

=AVERAGE(RANGE) 

d) Copy this formula across to calculate average for primary and total number  

e) Save the file again 

f) Insert a column before District Click on Column Heading A – Click on Insert in Cells 

group 

g) Add S.NO. as column title and enter numbers 1 to 5.  

h) Add cells for minimum and maximum number of schools and calculate values these values. 

(Use =MIN(RANGE) and =MAX(RANGE) ) 

i) Insert a row between Jaipur and Kota Districts. Click onto Select row header of Kota 

(entire row would be highlighted) and Choose Home - Insert Sheet Row  

j) Add following data in the blank row 

k) Bhilwara  58 42 

l) Copy formula of total from Jaipur to Bhilwara in column E 

m) Observe that Total, Average and Minimum are automatically changed. Isn't it great again, 

no botheration about changing the formula or function?  

n) Change the value of Secondary schools to Jaipur from 124 to 139 and see where the result 

changes. 

o) Make Title of the table and heading row BOLD and Centre. Save the worksheet. 

p) Save the worksheet (It is always advisable to keep saving worksheet by pressing CTRL S) 

q) Try learning Merge and Centre  

r) Add a column after Total with heading % of Primary Schools to Total. 
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s) Calculate above value (Hint: cell references of Primary Schools/ Total * 100)  

t) Once % is calculated copy this to rest of the cells (down) 

u) Save the worksheet and exit from EXCEL 
 

Exercise 3: KORES Co. keeps the employee's payroll data in a worksheet as shown below: 

Kores Company Limited, Jaipur 

S. No. Name Earning 

Basic 

Pay 

HRA DA CCA Gross Salary 

1.  Rakesh 178000     

2.  Naveen 123500     

3.  Krishan 27500     

4.  Savitri 69500     

5.  Gopal 48000     

6.  Manish 30500     

7.  Amit 124000     

 Total      

 

a. Enter the above data in a worksheet and save the workbook as EMPLOYEE. 

b. In the third column we need to type text BASIC PAY in the same cell and want that it should be 

displayed in two lines in the same cell. Select the entire row and click on   (Wrap Text in the 

Alignment Group of the Home Tab).  

c. Make Title of the Worksheet (Kores Company Limited, Jaipur) as BOLD and also place 

in the Centre of the four Columns in which data is typed. (Select seven cells on top of the 

columns, Click on to Merge and Centre Icon on the Tool Bar.  

d. Calculate HRA (16 % of Basic Pay), DA (21% of Basic Pay), CCA is fixed amount of Rs 1000. 

Also calculate Gross Salary which is sum of Basic Pay, DA, HRA and CCA.  

e. Select the data you have entered and put border on all the cells using Border in Font Group of 

HOME tab. Save your workbook and exit.  

 

Exercise: 4: Open the file EMPLOYEE created in Exercise 3 and add following columns after Gross 

Salary 
 

Deductions Net Salary 
GPF SI Total  

 

 

a. Calculate GPF and SI, rules for calculating these are as follows. 

I. GPF  - 6000 is deducted if basic pay is less than 55000, else 8500 is deducted.  

II. SI, which is 2000 for everyone irrespective of grade pay. Also fill up Total Deduction 

and Net Salary. 

b. Save the workbook again. 

c. Change Basic Pay of two or employee and check whether the effects of above changes are 

reflected in gross salary and net salary. 

d. Save the file.  

e. Change the formula for calculating SI premium in such a way that 20% of basic pay is deducted 

for employees getting basic pay more than 80000 and for others SI deduction is 15%. 

 

  



5 
 

Exercise – 5: Prepare the following worksheet: 

 

ABC Consultants, Jaipur 

  Item Quantity Unit Price Gross Value 

I7 Computer System 2 55000.00  

Notebook i5 2 43000.00  

Printer 2 12000.00  

Pen Drive 15 560.00  

Total  Gross    

Discount  7%  

Amount Payable    

Tax on Amount Payable  4.5%  

Net Amount Payable    

 

a. Increase the width of the Column A in such a way that entire data is accommodated in the 

column. 

b. Enter a formula to calculate the gross value for I7 Computer System. (Remember * is used for 

Multiplication) 

c. Copy this formula for rest of the items 

d. Calculate the total of the Gross Values for the all the products using SUM Function. 

e. Calculate the Discount, which has been given as 7%. (Do not panic if you type 7% and it 

shows .07). 

f. Calculate the Amount Payable after subtracting Discount Amount form the Total Gross and 

also calculate Tax and Net Amount Payable.  

g. Change the discount rate to 8% and see the changes. Also change Tax Rate to 6.25% and 

observe the changes. 

h. Make Title of the Worksheet (AMC Consultants, Jaipur) as BOLD and also place 

in the Centre of the four Columns in which data is typed. (Select four cells on top 

of the columns, Click on  to Merge and Centre Icon on the Font Group of the HOME tab.  

i. Change discount percentage value from 7% to 10% and see what changes are reflected. Save 

the worksheet as ITEM. 

 

j. Using Goal Seek - Suppose you want that you have an amount available with you of Rs 169800. 

than how much discount should be offered to you so that you are able to purchase items indicated 

above. How will you approach this issue - GUESS. 

 

Select DATA tab – Data Tools – What if Analysis - GOAL SEEK 

option and specify desired information  
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Exercise - 6 

Prepare a worksheet as under and fill in the blanks using Worksheet features. 

Rajasthan Financial Corporation 

S.No Particulars Target Expenditure/ Utilized % 

Utilization 

   Up to last 

month 

Current 

month 

Total  

1.  Civil Works at the 

head Office 

345000 115000 145000   

2.  Gardening  80000 7000 15000   

3.  Machinery & 

Equipments for the 

office  

315000 273000 17000   

4.  Vehicles 277000 0 217000   

5.  Training for officers 

and employees 

70000 42300 0   

6.  Technical Assistance 5000 1000 3000   

7.  Furniture/Fixture 15000 2000 9000   

8.  Salaries & Allowances 490430 139000 47000   

9.  Operating Costs 71000 13000 21000   

10.  Miscellaneous 30000 1000 2500   

 Total      

 

a. Format the worksheet as above. Most of the features to format the worksheet have already been 

covered in the previous exercises. Select Column heading and give them a different colours. 

(Home – Styles - Cell Styles and select appropriate Style).   

b. Calculate % utilization of the target. Select different formatting for 

cells  for % Utilization 

c. Save the worksheet as RFC. 

d. Using Goal Seek - Suppose you want that % utilization for Civil 

Works should be 96.5%, than how much amount should be the 

expenditure in the current month. How will you approach this 

issue - GUESS. 

e. Select DATA tab – Data Tools – What if Analysis - GOAL 

SEEK option and specify desired information e.g. in the Set Cell specify cell address of the % 

utilization of civil works i.e. G4, in the to value - enter 96.5 and by changing cell - E4. Click 

OK after specifying these values. 

 

Exercise - 7 

The following statement shows that actual expenditure incurred on various account heads at RIPA for 

last three years. Prepare the following worksheet. 

Budget of HCM RIPA 

S. 

No. 

Account Head Actual Expenditure Average 

of last 

three 

years 

Estimate for 

2020-21 

% increase 

over 2017-18 

  2017-18 2018-19 2019-20    

1 Salaries 800000 830000 850000    

2 Travel Expenses 70000 90000 100000    

3 Medical Charges 60000 70000 75000    

4 Office Expenses 110000 130000 170000    

5 Advt., Sales & 

Publicity Expenses 

8000 9000 12000    

 Total :       
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After completion of worksheet, perform the following: 

a. Place Title (Budget of HCM RIPA) in the centre of the table.  

b. Format the heading row of the table in such a way that data is displayed as given above, i.e. 

longer text is displayed in more than one line in the same cell. (Hint: Select the cells and click 

on   (Wrap Text in the Alignment Group of the Home Tab).  

c. Make heading row as BOLD and CENTER 

d. Calculate the total expenditure for all the account head for each year. Also calculate average 

expenditure for last three years. 

e. Calculate the estimates for the year 2020-21 by assuming that it is 15% higher than the average 

of last three years 

f. Calculate the increase in percentage for the year 2020-21 with respect to the year 2017-18. 

(Increase is calculated after subtracting 2017-18 expenses from the estimate for the year 2020-

21 and dividing it by expenditure of the year 207-18. 

g. Draw Border around the Table by Clicking onto BORDER Icon on the Font Group of HOME 

tab.  

h. Save the worksheet as BUDGET. 

i. Exit form MS Excel. 

 

Exercise – 8 Prepare following spreadsheet to see the expenses incurred on various items. 

 

S. 

No. 

Item name Amount 

Spent 

% Expenses of Total 

Expenditure 

1 House Rent 3000  

2 Milk 970  

3 Kitchen 1750  

4 Bills 1950  

5 Education 1200  

6 Petrol 2500  

7 Entertainment 560  

8 Miscellaneous 800  

 Total   

 Salary Received 23500  

 Savings from Salary   

 

a. Format the worksheet as given above and also calculate total expenditure. 

b. Salary Received is also given; therefore calculate monthly savings from the salary. 

c. Also calculate % expenses incurred on each head of the total. Remember when you copy the 

formula down; the cell references are automatically changed. Therefore you need to keep total 

as constant by using in the formula before row number of the total. 

d. How much would you be saving if Entertainment expenses were increased to 1350? 

e. Save the worksheet as HOUSE-BUDGET. Exit from MS Excel. 

 

Exercise – 9: Open the worksheet school created in exercise- 1 which is as follows. 
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Prepare a COLUMN chart-taking District on the X-

axis and number of Secondary Schools on the Y-axis 

using the following steps: 

a. Select data consisting of district names, 

secondary school and primary school. 

b. Click onto INSERT TAB and select COLUMN 

from CHARTS group.  

c. Select Column chart type. 

d. The chart as displayed will be shown. 

 

Exercise 10: Apply a Chart Layout 

Since we do not have titles for the chart, x –axis and y-axis therefore by applying layout we can place 

these titles on the chart.   

a. Click your chart. The Chart Tools become available. 

b. Choose the Design tab. 

c. Select appropriate chart layout (Layout 9) from 

Chart Layout group.  

d. Excel applies the layout to your chart. 

e. In Chart Title Box, Type Comparison of Schools in 

Rajasthan. 

f. In X Axis Title), type District 

g. In Y Axis Title, type No. of Schools 

h. Save the file. 

 

Exercise – 11 – Moving Chart to new sheet 

a. Click your chart. The Chart Tools become available. 

b. Choose the Design tab.  

c. Click the Move Chart button in the Location group. The Move Chart dialog box appears. 

d. Click the New Sheet radio button. 

e. Type School Comparison - to name the chart sheet. Excel creates a chart sheet named School 

Comparison and places your chart on it. 

 

Exercise 12: Prepare a Pie Chart showing % of primary schools in each of the district of the total 

primary school.  

a. The Title of the Graph should be Distribution of Primary Schools.  

b. The Chart should be placed on a separate sheet called Primary School  

c. The Category Data and % should be displayed outside the chart. (Layout – Data Labels -  More 

Label Options)   
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